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I. PENDAHULUAN 

Getaran adalah gejala mekanika dinamik yang 

mencakup periode gerak osilator di sekitar posisi referensi atau 
berupa gerakan bolak-balik yang digambarkan sebagai amplitudo 

atau simpangan terjauh  dari  titik  setimbang. Untuk mendeteksi 

getaran suatu objek dengan memanfaatkan informasi getaran 

diperlukan sensor getaran Untuk mendeteksi getaran 
dikembangkan berbagai alat berupa sensor getaran. Terdapat 

banyak metode atau teknik  yang dipakai untuk mendeteksi 

getaran, misalnya dengan teknik perubahan kapasitansi,  

perubahan  muatan  listrik  dari  material  piezoelectric    atau  
perubahan  posisi  dalam Linear Variable Displacement 

Transformer (LVDT), menggunakan laser, dan lain-lain . Sensor- 

sensor  tersebut  biasanya  harus  ditempelkan  ke  objek  yang  

akan  diamati  getarannya, alat tersebut akan berkerja dan 
menampilkan hasil pengukuran, Alat  ukur  getaran  frekuensi  

rendah  saat  ini  sangat  dibutuhkan,  seperti  deteksi  getaran 

bendungan, jembatan, bangunan dan gempa serta pada benda 

benda yang menghasilkan getaran 

Personal Computer (PC) digunakan untuk 

menampilkan bentuk grafik serta menyimpan data. Bagaimana 

cara merancang penerapan sensor accelerometer sebagai alat ukur 

getaran , menampilkan hasil ukur dan representasi sinyal 
pengukuran  getaran pada tampilan LCD dan PC mengetahui 

karakteristik sensor accelerometer. 

II. STUDI PUSTAKA 
 Rancang Bangun Alat Ukur Getaran Menggunakan Sensor 

Accelerometer Berbasis Mikrokontroler Atmega16 Dengan 

Tampilan Pc. Grafik hasil pengukuran  dapat dilihat melalui 

tampilan PC dan data pengukurannya dapat di simpan. 
2.1 Sensor Accelerometer MMA7361L 

Accelerometer adalah sebuah tranduser yang berfungsi 

untuk mengukur percepatan, mendeteksi dan mengukur getaran, 

ataupun untuk mengukur percepatan akibat gravitasi bumi. 
Accelerometer juga dapat digunakan untuk mengukur getaran 

yang terjadi pada kendaraan, bangunan, mesin, dan juga bisa 

digunakan untuk mengukur getaran yang terjadi di dalam bumi, 

getaran mesin, jarak yang dinamis, dan kecepatan dengan ataupun 
tanpa pengaruh gravitasi bumi. 
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Percepatan merupakan suatu keadaan berubahnya kecepatan 

terhadap waktu. Bertambahnya suatu kecepatan dalam suatu 

rentang waktu disebut juga percepatan (acceleration). Jika 
kecepatan semakin berkurang daripada kecepatan sebelumnya, 

disebut deceleration. Percepatan juga bergantung pada 

arah/orientasi karena merupakan penurunan kecepatan yang 

merupakan besaran vektor. Berubahnya arah pergerakan suatu 

benda akan menimbulkan percepatan pula. 

 
Gambar 1  Accelerometer mma7361L 

 

 
Gambar 2. Rangkaian accelerometer mma7361L 

2.2. Prinsip Kerja Accelerometer 

Prinsip kerja dari tranduser ini berdasarkan hukum 
fisika bahwa apabila suatu konduktor digerakkan melalui suatu 

medan magnet, atau jika suatu medan magnet digerakkan melalui 

suatu konduktor, maka akan timbul suatu tegangan induksi pada 

konduktor tersebut. Accelerometer yang diletakan di permukaan 
bumi dapat mendeteksi percepatan 1g (ukuran gravitasi bumi) 

pada titik vertikalnya, untuk percepatan yang dikarenakan oleh 

pergerakan horizontal maka accelerometer akan mengukur 

percepatannya secara langsung ketika bergerak secara horizontal. 
Hal ini sesuai dengan tipe dan jenis sensor Accelerometer yang 

digunakan karena setiap jenis sensor berbeda-beda sesuai dengan 

spesifikasi yang dikeluarkan oleh perusahaan pembuatnya. Saat 
ini hamper semua sensor/tranduser accelerometer sudah dalam 

bentuk digital (bukan dengan sistem mekanik) sehingga cara 

kerjanya hanya bedasarkan temperatur yang diolah secara digital 

dalam satu chip. Yang telah di set dalam sebuah chip untuk 
mengukur suatu keadaan,yang dapat digunaan dalam suatu 

keperluan dalam bidang teknologi dalam kehidupan teknologi 

modern. Sensor accelerometer tersedia dalam banyak versi sesui 

dalam hal keperluan pemakaian yang akan digunakan 
Sensor accelerometer ini beroperasi pada tegangan 2,2–

3,6 volt dengan tegangan tipikal 3,3 volt (Vdd). Keluaran sensor 

accelerometer berupa tegangan analog yang merepresentasikan 

data percepatan dalam satuan gravitasi (g). Pengesetan dilakukan 
dengan memberikan input logika 0 pada pin 1 dan pin 2 pada pin 

g-select1 dan g-select2. 

2.3. Mikrokontroler ATMega16 

 Mikrokontroler adalah sebuah sistem komputer lengkap 
dalam satu serpih (chip). Mikrokontroler lebih dari sekedar 

sebuah mikroprosesor karena sudah terdapat atau berisikan ROM 

(Read-Only Memory), RAM (Read-Write Memory), beberapa 

bandar masukan maupun keluaran, dan beberapa peripheral 
seperti pencacah/pewaktu, ADC (Analog to Digital converter), 

DAC (Digital to Analog converter) dan serial komunikasi. 

 Seperti mikroprosesor pada umumnya, secara internal 

mikrokontroler ATMega16 terdiri atas unit-unit fungsionalnya 

Arithmetic and Logical Unit (ALU), himpunan register kerja, 

register dan dekoder instruksi, dan pewaktu beserta komponen 

kendali lainnya. Berbeda dengan mikroprosesor, mikrokontroler 

menyediakan memori dalam serpih yang sama dengen 

prosesornya (in chip). 

 

2.4. Konfigurasi pena (Pin) ATMega16 

Konfigurasi pena (pin) mikrokontroler Atmega16 

dengan kemasan 40-pena dapat dilihat pada Gambar 2.3. Dari 

gambar tersebut dapat terlihat ATMega16 memiliki 8 pena untuk 

masing-masing bandar A (Port A), bandar B (Port B), bandar C 

(Port C), dan bandar D (Port D). 

 
Gambar 3. Konfigurasi Pin Atmega16 

2.5. Deskripsi Mikrokontroler ATMega16 

a) VCC (Power Supply) dan GND(Ground) 

b) Port A (PA7..PA0) 

 Port A berfungsi sebagai input analog pada konverter 
A/D. Bandar A juga sebagai suatu bandar I/O 8-bit dua arah, jika 

A/D konverter tidak digunakan. Portr dapat menyediakan resistor 

internal pull-up (yang dipilih untuk masing-masing bit). Port A 

output buffer mempunyai karakteristik gerakan simetris dengan 
keduanya sink tinggi dan kemampuan sumber. Ketika port PA0 

ke PA7 digunakan sebagai input dan secara eksternal ditarik 

rendah, potr-port akan memungkinkan arus sumber jika resistor 

internal pull-up diaktifkan. Port A adalah tri-stated manakala 
suatu kondisi reset menjadi aktif, sekalipun waktu habis. 

c) Port B (PB7..PB0) 

 Port B adalah suatu bandar I/O 8-bit dua arah dengan 

resistor internal pull-up (yang dipilih untuk beberapa bit). Port  B 
output buffer mempunyai karakteristik gerakan simetris dengan 

keduanya sink tinggi dan kemampuan sumber. Sebagai input, port 

B yang secara eksternal ditarik rendah akan arus sumber jika 

resistor pull-up diaktifkan. Port B adalah tri-stated manakala 
suatu kondisi reset menjadi aktif, sekalipun waktu habis. 

d) Port C (PC7..PC0) 

 Port C adalah suatu bandar I/O 8-bit dua arah dengan 

resistor internal pull-up (yang dipilih untuk beberapa bit). Port C 
output buffer mempunyai karakteristik gerakan simetris dengan 

keduanya sink tinggi dan kemampuan sumber. Sebagai input, 

Port C yang secara eksternal ditarik rendah akan arus sumber jika 

resistor pull-up diaktifkan. Port C adalah tri-stated manakala 
suatu kondisi reset menjadi aktif, sekalipun waktu habis. 

e) Port D (PD7..PD0) 

 Port D adalah suatu bandar I/O 8-bit dua arah dengan 

resistor internal pull-up (yang dipilih untuk beberapa bit). Port  D 
output buffer mempunyai karakteristik gerakan simetris dengan 

keduanya sink tinggi dan kemampuan sumber. Sebagai input, 

Port D yang secara eksternal ditarik rendah akan arus sumber jika 

resistor pull-up diaktifkan. Pena Bandar D adalah tri-stated 

manakala suatu kondisi reset menjadi aktif, sekalipun waktu 

habis. 

a) RESET (Reset input) 
b) XTAL1 (Input Oscillator) 

c) XTAL2 (Output Oscillator) 

d) AVCC adalah pena penyedia tegangan untuk bandar A 

dan Konverter A/D. 
e) AREF adalah pena referensi analog untuk konverter 

A/D. 

2.6.  LCD (Liquid Crystal Display) 

  LCD merupakan salah satu perangkat display yang bisa 
menampilkan gambar atau karakter yang diinginkan. Dalam 

hubungannya dengan mikrokontroler, LCD dapat menampilkan 

kejadian dalam suatu program yang telah dimasukan ke dalam 

../../MURDANI/web/Triple%20Axis%20Accelerometer%20MMA7361%20%20%20Famosa%20Studio_files/Triple%20Axis%20Accelerometer%20MMA7361%20%20%20Famosa%20Studio.htm
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chip ketika chip tersebut dijalankan. LCD yang digunakan 

mempunyai lebar display 2 baris 16 kolom atau biasa disebut 

sebagai LCD karakter 2x16, dengan 16 pin konektor, yang 
didifinisikan sebagai berikut: 

 

 

 
Gambar  2.6 Line LCD Karakter 2x16 

 
Gambar  4  Modul LCD Karakter 2x16 

LCD atau Liquid Crystal Display  adalah suatu jenis 

media tampilan yang menggunakan kristal cair sebagai penampil 

utama. Dalam proyek akhir ini penulis menggunakan LCD yang 

dapat menampilkan ininsial perancang dan tampilan setting 
waktu maupun temperature yang di inginkan dengan lebih jelas 

dan akurat. 

 

2.7. Usb Serial To Rs232 Uart Ttl 
Rangkain USB to Serial adalah rangkaian yang 

digunakan untuk mentranfer data dari mikrokontroler dengan PC. 

Hal ini karena untuk membuat komunikasi antara mikrokontroler 

dengan PC atau device lainnya, pin RXD dan TXD pada 
mikrokontroler tidak bisa langsung di hubungkan pada PC atau 

device tersebut karena level sinyal yang digunakan oleh 

mikrokontroler dan device tersebut berbeda. Oleh karena itu 

digunakanlah rangkaian USB to serial. 

 
Gambar 5.  Usb Serial To Rs232 Uart Ttl 

 

2.8. Microsoft Visual Basic 6.0 
   Program Microsoft Visual Basic merupakan bahasa 

pemrograman tingkat tinggi ( High Level Languange). Microsoft 

Visual Basic juga merupakan bahasa pemrograman Object  

Oriented  Programming  (OOP),  yaitu  pemrograman 
berorientasi pada objek. Microsoft Visual Basic memiliki 

beberapa versi yaitu Microsoft Visual Basic 3.0, Microsoft Visual 

Basic 5.0, Microsoft Visual Basic Versi 6.0, VB. Net. Dan 

mungkin akan berkembang lagi dengan berbagai versi dan 
semakin sempurna dalam penggunaannya.Menurut Kusrini 

(2007:171), “Visual Basic adalah salah satu bahasa pemrograman 

komputer”. Bahasa pemrograman adalah perintah-perintah yang 

dimengerti oleh komputer untuk melakukan tugas-tugas tertentu. 
Visual Basic merupakan salah satu development tool, yaitu alat 

bantu untuk membuat berbagai macam program komputer, 

khususnya yang menggunakan sistem operasi windows.Menurut 

Suhata, (2005:3), “Visual Basic 6.0 merupakan salah satu bahasa 
pemrograman yang dapat digunakan untuk menyusun dan 

membuat program aplikasi pada lingkungan sistem operasi 

windows”. Program aplikasi dapat berupa program database, 

program grafis, dan lain sebagainya. Berikut langkah – 
langkahnya secara lengkap: 

a. Tekan tombol start dari task bar pada windows. 

b. Pilih All Program, dan arahkan ke pilihan Mikrosoft 

Visual Studio 6.0 dan klik pada pilihan Mikrosoft Visual 

Basic6.0. Lihat gambarnya di bawah ini: 

 
Gambar 2.9 Membuka program visual basic 6.0 

c. Setelah berhasil menjalankan visual basic untuk yang pertama 

kalinya anda akan melihat tampilan logo visual basic 6.0 dan 

tak lama kemudian akan muncul kotak dialog berikut: 

 
Gambar 6. Tampilan Kotak Dialog new project 

 

Kotak dialog tresebut meminta konfirmasi untuk memilih tipe 
proyek yang ingin kita buat. 

d. Dalam hal ini, pilih tipe proyek VB Enterprise Edition 

Control. Tekan tombol Open untuk  melanjutkan.  

e. Dengan pemilihan tipe VB Enterprise Edition Control 
diatas,seorang pengguna tidak   perlu lagi menambahkan 

komponen yang di perlukan. Hal itu karena tipe proyek 

tersebut  sudah  menyediakan komponen-komponen secara 

lengkap. Tekan tombol Open untuk  melanjutkan.   
f. Setalah menekan tombol Open, akan muncul sebuah layar 

program visual basic dengan disertai komponen – komponen 

lengkap yang ada pada bagian General atau Toolbox. 

 
Gambar 7 Tampilan Kotak Blok Form 

 

g. Tampilan diatas dapat disebut dengan lingkungan 

Intergrated Development Environment  (IDE). Pada 
lingkungan tersebut, anda dapat melakukan berbagai 

aktivitas seperti proses editing, dan debugging. 

h. Tampilan awal Visual Basic 6.0 

 
Gambar 8. Tampilan Kotak Menu File 

 

 



Journal of Informatics and Computer Science Vol. 8 No. 2 Oktober 2022 
Universitas Ubudiyah Indonesia  
e-ISSN : 2615-5346     

133 
 

2.9. IDE Visual Basic 

  Langkah dari belajar Visual Basic adalah mengenal 

IDE (Intergrated Development Environment) Visual Basic yang 
merupakan lingkungan pengembangan terpadu bagi programmer 

dalam mengembangkan aplikasinya. Dengan menggunakan IDE 

programmer dapat membuat user interface, melakukan koding, 

melakukan testing dan debugging serta mengkompilasi program 

menjadi executable. Penguasaan yang baik akan IDE sangat 

membantu programmer dalam mengeefektifkan tuags – tugasnya 

sehingga dapat bekerja dengan efisien. 

2.10. Pemakaian Komponen 
Layar Visual Basic hampir sama dengan layar program-

program aplikasi windows pada umumnya. Kita dapat memindah-

mindahkan, menggeser, memperbesar atau memperkecil ukuran 

setiap komponen layar Visual Basic seperti kita memanipulasi 
layar windows. Masing – masing komponen memiliki atribut 

tersendiri dalam melakukan aksi kendali. 

2.11. Menu 

Menu merupakan perintah yang dipakai dalam MS 
Visual Basic. Berikut merupakan contoh tampilan salah satu 

menu MS Visual Basic. 

 
Gambar 9. Tampilan menu MS Visual Basic. 

Pada kotak dialog tersebut terdapat  tiga pilihan dengan 

keterangan yang terdapat pada tabel sebagai berikut dan gambar 

tampilan dasar dari Visual Basic diperlihatkan pada gambar 

dibawah ini: 

Tabel 2.3    Keterangan Pada Kotak Dialog 

Tabualasi Keterangan 

New Pilihan digunakan untuk membuat project baru 

dengan berbagai macam pilihan 

Exitring Pilihan ini digunakan untuk membuka project yang 

pernah dibuat sebelumnya dengan menentukan 

folder sekaligus nama file 

Recent Pilihan ini digunakan untuk membuka project yang 

telah dibuat dan terakhir kali dibuka. 

 

Setelah kita keluar dari layar New project, selanjutnya 

akan tampil layar kerja atau area kerja dari Visual Basic 6.0 . 

keterangan dari gambar diatas adalah sebagai berikut: 

a. Tool Bar 

   Kehadiran tombol-tombol speed pada toolbar akan 

sangat membantu dalam mempercepat akses perintah (yang bias 
jadi tersembunyi di dalam tingkat-tingkat hirarki). Sebab tombol 

speed berfungsi sama dengan perintah yang tersedia (dan 

tersembunyi) di dalam menu. Adapun gambarnya terdapat pada 

gambar di bawaah ini: 
 

 
Gambar 10. Tampilan toolbar 

b. Toolbox 

 Toolbox adalah tempat penyimpanan kontrol yang akan 

kita gunakan pada program yang dipasangkan pada form. VB6 

menyediakan 21 kontrol, masing-masing dapat dilihat pada 
tabelberikut : 

 
 

Gambar 11. Tampilan toolbox 

c. Properties Windows 

Window ini bertugas menyiapkan segala properti dari 

objek yang diperlukan dalam perancangan user interface maupun 
pemrograman.Pada window ini terdapat semua properti yang 

dimiliki oleh objek terpilih (cara memilih objek adalah klik objek 

langsung pada diagram di project explorer atau klik langsung 

pada objeknya, misalnya form).Pada windows ini terdapat dua tab 
yang menampilkan properti dalam dua cara sesuai dengan nama 

tab yaitu tab Alphabet (diurutkan berdasarkan namanya sesuai 

dengan abjad, ini merupakan pilihan default) dan Categories 

(diurutkan berdasarkan fungsinya). Masing-masing properties 
memiliki nilainya sendiri-sendiri yang telah disediakan VB6 atau 

kita isikan sesuai dengan kebutuhan. 

 

 
Gambar 12. Tampilan toolbox 

 

d. Jendela Form Designer 
 Form Designer digunakan untuk mengatur tata letak 

form pada layar monitor. Seringkali menempatkan form sehingga 

untuk mendapatkan posisi yang kita inginkan, setiap kali kita 

harus menjalankan program unuk mengetahui posisi dari hasil 
penyetelan yang kita lakukan. Dengan adanya window form 

layout ini pekerjaan yang berulang-ulang yang tidak kita inginkan 

tersebut dapat dihindari. Untuk membuka Form Designer dapat 

mengklik menu  > object. 

 
Gambar 13. Tampilan Jendela Form Designer 

e. Jendela Kode 

 Jendela kode merupakan tempat untuk menuliskan kode 
– kode bagi objek yang dibuat. Melalui jendela ini dapat 

mengatur karateristik dari form yang di buat. Bila jendela kode 

tidak muncul klik tombol view code dibagian Project Explore 

atau klik View > Code. 

 
Gambar 14. Tampilan Jendela Kode 

f.  Project Explorer 
  Project Explorer berfungsi berbagai saran pengakses 

bagian-bagian pembentuk project. Pada windows ini terdapat tiga 

tombol pengaktif untuk Windows Code, Windows Object dan 
Toggle Folder. Juga terdapat diagram yang menampilkan susunan 

http://1.bp.blogspot.com/-kFLRIQ92yaE/TWYTAPWMUyI/AAAAAAAAAIw/rdgQFhWFA28/s1600/k.jpg
http://1.bp.blogspot.com/-n0KQLkLFSCU/TWJvWlsWPVI/AAAAAAAAAHI/IJkuSdQEGgM/s1600/as.jpg
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folder penyimpanan file-file project.Secara default windows ini 

menempati dock-nya sendiri, yaitu di sebelah kanan atas. Namun 

kita bisa membuatnya mengambang keluar dock dengan cara 
mengklik atau drag keluar judul windows ini.Untuk menampilkan 

windows ini dengan caranya adalah Dari menu View pilihlah 

Project Explorer dan  Tekan tombol CTRL +R pada keyboard 

 
Gambar 15. Tampilan Project forms 

g.  Properti window 

    Window ini bertugas menyiapkan segala properti dari 

objek yang diperlukan dalam perancangan user interface maupun 
pemrograman.Pada window ini terdapat semua properti yang 

dimiliki oleh objek terpilih (cara memilih objek adalah klik objek 

langsung pada diagram di project explorer atau klik langsung 

pada objeknya, misalnya form). Pada windows ini terdapat dua 
tab yang menampilkan properti dalam dua cara sesuai dengan 

nama tab yaitu tab Alphabet (diurutkan berdasarkan namanya 

sesuai dengan abjad, ini merupakan pilihan default) dan 

Categories (diurutkan berdasarkan fungsinya). Masing-masing 
properties memiliki nilainya sendiri-sendiri yang telah disediakan 

VB6 atau kita isikan sesuai dengan kebutuhan. Cara 

menampilkan window ini caranya :menekan Menu View pilihlah 

Properties Window dan  tombol F4 pada keyboard 
 

 
Gambar 16.  Tampilan propeties form 

                                                                                                                                                                      

h. Visual Basic 6.0 dengan Design Sistem GUI 
   Penggunaan mikrokontroller Atmega 16 

membutuhkan Software pendukung. Software- Software  

pendukung ini berfungsi antara lain untuk teks editor dalam 

penulisan baris- baris perintah, dan Visual Basic digunakan untuk 
design system GUI yang berkorelasi dengan obyek yang dipakai 

untuk proses Visual Basic 6.0  yang mengubah program sumber 

Visual Basic menjadi program obyek maupun bahasa C, dan 

untuk  men- download  program Visual Basic 6.0  ke flash 
memori Atmega 16. Untuk merancang suatu alat yang 

menggunakan mikrokontroller, maka harus ditentukan port pada 

mikrokontroller, yang dapat dinyatakan sebagai input maupun 

output.    

III. METODE 

Alat Ukur Getaran  Menggunakan Sensor Accelerometer berbasis 

Mikrokontroler Atmega16  Dengan Tampilan PC yang di kontrol 
menggunakan program yang berbasis mikrokonroler dengan 

menggunakan  blok  diagram seperti di bawah ini. 

 

 

3.1 Blog Diagram 

 
Gambar 1.  Blok Diagram Rangkaian 

Fungsi masing-masing blok diagram 
a. Objek benda Sumber yang menghasilkan getaran 

b. Sensor berfungsi sebagai pengubah dari kecepatan 

getaran kepulsa- pulsa gelombang sinus. 

c. Mikrokontroler AT Mega16 berfungsi untuk 
memproses data yang dihasilkan oleh sensor sebelum 

ditampilkan di LCD dan dikirim  ke PC melalui 

komunikasi serial to USB 

d. LCD (Liquid Crystal Display) berfungsi untuk 
menampilkan hasil pembacaan yang dibaca oleh sensor  

e. Komunikasi Serial To Usb berfungsi sebagai alat 

mengirim data yang telah diproses pada mikrokontroler 

ke PC.  
f. PC (Personal Computer) berfungsi untuk 

menampilkan grafik getaran dari hasil pengukuran alat 

dan menyimpan data di data base. 

3.2.  Pembuatan rangkaian yang terdiri dari sebuah rangkaian 
mikrokontroler, rangkaian sensor accelerometer, rangkaian LCD 

dan rangkaian serial to usb. Serta di lengkapi juga dengan 

beberapa rangkaian tertentu yang membuat alat menjadi lebih 

sederhana dan memiliki kestabilan yang tinggi yang akan 
mendukung kinerja alat secara keseluruhan. 

3.3 Catu Daya 

Catu daya merupakan rangkaian elektronika yang dapat 

memberi sumber tegangan DC untuk input sebagai tengangan 
kerja komponen  

 

 

 
 

 

 
 

 

 

 
Gambar 2 Rangkaian Catu Daya 

 

3.3  Rangkaian Sensor Accelerometer 

Sensor Accelerometer merupakan sensor yang sensitif 
terhadap perubahan kecepatan getaran, Perubahan getaran yang 

dibaca oleh sensor dikirim dalam bentuk besaran fisis kemudian 

dikirim ke mikrokontroler untuk merubah ke dalam bentuk arus. 

 

 
Gambar 3 Rangkaian Sensor Accelerometer 
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Gambar 4 Rangkaian Sensor Accelerometer masuk ke mikro 

 
3.4  Rangkaian Mikrokontroler Atmega16 

Mikrokontroler ATMega16 adalah sebagai pengendali 

utama ( otak ) dari keseluruhan proses kerja dari alat tersebut. 

Suatu mikrokontroler akan menerima data dari sensor 
accelerometer lalu mikrokontroler akan memproses hasil kiriman 

sensor kemudian mengirim data yang di hasil kan dari 

mikrokontroler. Selanjutkan data akan di kirim ke LCD dan 

ditampilkan pada LCD dan bisa juga di tampilkan pada PC dalam 
bentuk grafik yang di kirim melalui komunikasi Serial To Usb  

 

 
Gambar 5  Rangkaian Mikrokontroler Atmega16 

3.5  Rangkaian Reset 
Rangkaian tombol reset mikrokontroler yang berfungsi 

sebagai tombol reset mikrokontroler. Apabila mikrokontroler 

tidak membaca data yang di kirim sensor maka menekan tombol 

reset supaya kembali ke keadaan ulang, Adapun rangakain reset 
sebagai berikut: 

 
Gambar 6 Rangkaian Tombol Reset 

 
3.9  LCD (Liquid Crystal Display) 

             Seperti terlihat pada gambar 3.3, hanya beberapa pin 

yang digunakan pada LCD untuk dihubungkan dengan 

mikrokontroller, pin tersebut dihubungkan sesuai dengan nama 
yang tertera pada mikrokontroller yaitu R/W ke port PB.1 ,            

RS ke port PA.0 , E ke port PB.2 ,D4 ke port PB.4 , D5 ke port 

PB.5 , D6 ke port PB.6 ,dan D7 ke port PB.7 . LCD karakter 16x2 

ini dapat menampilkan karakter sesuai dengan table ASCII, untuk 
dapat dihubungkan dengan mikrokontroller. 

 
Gambar  7.  Rangkaian LCD (Liquid Crystal Display) 

3.4. Rangkaian Serial to USB 
 Rangkaian Serial to USB merupakan rangkaian yang 
digunakan untuk mengirim data dari mikrokontroler ke PC.untuk 

di tampilkan pada VB dalam bentuk grafik. 

 
Gambar  8.  Rangkaian Serial to USB 

3.6 Rangkaian Tombol Tekan 

  Tombol tekan merupakan komponen kontrol yang 
sangat berguna untuk menentukan pengaturan menu yang akan di 

inginkan, tombol tekan ini juga sebagai input untuk masukan 

mikrokontroler.  

 
Gambar 9  Rangkaian Tombol Tekan 

3.7  Perangkat Lunak (Software) 

  Perangkat lunak yang dibuat harus dapat 
mengintergrasikan seluruh peralatan pendukung yang digunakan 

dalam pembuatan alat ukur getaran, Mikrokontroler juga harus 

mampu mengolah data-data masukan maupun data-data keluaran 

dari peralatan yang dikontrol. 

3.8  Penentuan Alamat Mikrokontroler 
 Penentuan alamat bit pada modul Mikrokontroler dapat 

ditentukan dari penggunaan alamat yang sudah tersedia pada 

modul Mikrokontroler, dimana alamat bit yang tersedia adalah 
sebanyak 32 bit untuk input/output dan dapat dibagi menjadi 

beberapa bagian. 

Tabel 3.1 Perancangan Input/Output (I/O) 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

Port Bit Fungsi 

Port A PA0 - PA2 Data input dari Sensor 

Port B PB0 - PB7 Tampil LCD 

Port C PC0 – PC3 Tombol tekan 

Port D PD0 – PD1 Serial USB TTL 
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3.9  Program  Utama 

  Program utama merupakan suatu sistem yang 

dieksekusi setelah peralatan diaktifkan dan program yang 
memegang seluruh subrutin-subrutin program. Program yang 

dipakai dalam penyelesaian tugas akhir ini menggunakan bahasa 

assembly. Proses pembuatan program harus direncanakan 

seefektif mungkin dengan memperhatikan karakteristik dari 

peralatan pendukungnya. Program dimulai dengan inisialisasi 

alamat variable sehingga dapat mempermudah pembuatan 

program dengan kata-kata yang telah kita perkenalkan terlebih 

dahulu.  Software yang berupa program ASM yang diwujudkan 
dengan program Codevision AVR, digunakan untuk mengatur 

segala aktifitas pada sistem, mulai dari perhitungan nilai masukan 

sensor, mengoperasikan motor, heater dan pengaturan sistem 

lainnya. AVR STUDIO merupakan software khusus untuk bahasa 
assembly  yang mempunyai fungsi sangat lengkap. Software AVR 

STUDIO digunakan untuk menulis program, kompilasi, simulasi 

dan download program ke IC mikrokontroller AVR. 

CodeVisionAVR merupakan software C-cros compiler. 
Software Code Vision AVR dapat ditulis dalam bahasa C. 

CodeVisionAVR memiliki (Integrated Development 

Environtment) IDE yang lengkap. CodeVisionAVR digunakan 

untuk penulisan program, compile, link, dan pembuatan kode 
bahasa mesin (assembler). 

 
Gambar 10  Ikon CodeVisionAVR pada Desktop 

3.10   Flowchart Alat 
  Sebelum membuat program, maka terlebih dahulu 

penulis merencanakan Flowchart sistem untuk memudahkan 

dalam perencanaan program yang akan dibuat. Flowchart tersebut 

menjelaskan sistem kerja, Flowchart yang akan dibuat dapat 
dilihat pada diagram aliran kerja alat di bawah ini: 

 

 

 
 

 

 

 
 

 

 

 
 

 

 

 
 

 

 

 

Gambar 11.  Bagan Alir Sistem 

 

3.11  Flowchart Program VB 

 Sebelum membuat program terlebih dahulu 
merencanakan bagan alir untuk memudahkan dalam perencanaan 

program yang akan dibuat untuk program VB. 

 
Gambar 12.  Bagan Alir Untuk Program VB 

 

3.12  Perangkat Lunak Komputer 

 perangkat lunak Visual Basic sangat menentukan 

kesamaan hasil akhir dari komunikasi mikrokontroler dengan 
komputer melalui USB serial dan menampilkan data asli dari 

mikrokontroller kedalam bentuk visual yaitu grafik. 

 

3.12 Design Tampilan Program GUI pada Visual Basic Berikut 
ini adalah perancangan tampilan software yang digunakan untuk 

menampilkan harga barang beserta keterangan terhadap software 

yang dibuat.  

 
Gambar 13.  Desain Tampilan Program 

IV. HASIL DAN PEMBAHASAN 

  Pengujian perangkat lunak ini bertujuan untuk 

mengolah data-data yang dihasilkan dari kerja sistem dan 
berkaitan dengan pengendali sistem alat. Sehingga dapat 

diketahui karakteristik kehandalan dan ketepatan eksekusi dari 

program yang telah dibuat serta untuk mengatahui kelemahannya. 

Pada analisisnya.  
Pengujian Sistem yang dilakukan ini berkaitan dengan secara 

terintegrasi dari semua komponen hardware dan software. 

4.1. Pengujian Catu Daya 

Pengujian rangkaian power supply untuk mengetahui prinsip 
kerja rangkain Agar dapat mengetahui sesuai dengan  tegangan 

yang diberikan 9 V dengan hasil pengukuran seperti pada tabel di 

bawah ini. 

Tabel 1 pengujian power supply 
N

o 

Inp

ut  

baterai 

Tegangan 

Keluaran IC 7805 
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1 9 V 
4.9 V/DC 

 
 Output power supply untuk tegangan DC sebesar 9 V. 

Sedangkan untuk tegangan Output IC 7805 sebesar 4.9 V/DC, hal 

ini sesuai dengan tegangan yang dimasukan pada masing-masing 

komponen  
 

4.2 Pengujian Sensor Accelerometer 
Pengujian sensor accelerometer untuk mengetahui getaran yang 

ada pada benda yang akan diukurdan nilai perbedaan antara 
getaran yang dihasilkan  dapat dilihat pada tabel di bawah ini 

Table 2 Hasil pengukuran Sensor Accelerometer 

SUM

BU 

TEGANG

AN 

KELUARAN  

X 1,61 V 

Y 1,61 V 

Z 2,45 V 

 

Berdasarkan hasil pengujani sensor suhu dan kelembaban adalah 

Perubahan nilai getaran berbeda beda antara sumbu X,Ydan Z .ini 
di sebabkan karena tiap sumbu membaca pengukuran masing 

masing dan Subu X membaca perubahan posisi secara vertikal. 

Sumbu Y membaca perubahan posisi secara horizontal. Dan 

sumbu Y membaca perubahan posisi secara axial. 
 

4.3. Membuka CodeVisionAVR 

Membuka CodeVisionAVR dilakukan dengan memilih 

menu Start Menu → All Program CodeVisionAVR → 
CodeVisionAVR Compiler.  Setelah langkah tersebut dilakukan 

pada monitor akan tampil tampilan seperti gambar di bawah ini 

  

 
Gambar 1 Tampilan Awal CodeVisionAVR 

4.4. Membuat Project Baru 
Membuat project baru dilakukan dengan memilih menu 

File → New, kemudian memilih Project → OK. Setelah langkah 

tersebut dilakukan pada monitor akan tampil dialog Create New 

File seperti pada gambar dibawah ini 

 
Gambar 2. Konfirmasi Membuat Project Atau File 

 

Jika tombol OK dipilih maka akan muncul kotak dialog 
Confirm. Kotak dialog ini menanyakan apakah CodeWizardAVR  

akan digunakan atau tidak. Jika Codewizard akan digunakan 

maka tekan tombol YES. Kotak dialog confirm seperti pada 

gambar 4.3. 

 

Gambar 3. Konfirmasi Penggunaan CodeWizardAVR 

 

4.5 Membuat Kode Program 
Membuat kode program dilakukan dengan membuat file 

dan menamainya terlebih dahulu kemudian menyimpannya pada 

folder yang telah ditentukan. Langkah-langkah pembuatan file 

dilakukan dengan memilih menu File, Generate, save and Exit 
kemudian file source (*.c), file project (*.prj) dan file project 

code wizard (*.cwp) diberi nama dan disimpan pada folder yang 

telah ditentukan. Setelah langkah tersebut, pada monitor akan 

tampil program yang  siap  diisi  oleh  program  yang  dibuat.  
Form  program  seperti  pada gambar dibawah ini 

 

 
 

Gambar 4. Form Program 

4.6 Mengconfigure Program 

meng-configure program dilakukan dengan memilih 

menu Project → Configure → AfterBuild → program the Chip 

→ Ok. Dan untuk mengcompile Progrm Meng-compile program 
dilakukan dengan memilih menu Project / compile atau dengan 

memilih icon  → Program. Jika penulisan kode program benar, 

maka akan tampil kotak dialog information. Kotak dialog 

informatioan seperti pada gambar 5. 
 

 
Gambar 5 Kotak Dialog Information Configure 
 Mengkompile program bahasa c dengan CodeVision 

AVR. Kita perhatikan data atau alamat mikro yang kita ketik 

harus benar. Pada saat kita kompile tidak terjadi error. Bila 

terjadi error kita perbaiki  terlebih dahulu kesalahan yang di 
informsikan pada jendela Error. 

This program was produced by the 

CodeWizardAVR V2.05.3 Standard 
Automatic Program Generator 

© Copyright 1998-2011 Pavel Haiduc, HP InfoTech s.r.l. 

http://www.hpinfotech.com 

Project :  
Version :  

Date    : 6/8/2014 

Author  : kurobochan 

Company : www.indorobo.com 
Comments:  
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Chip type  : ATmega16 

Program type : Application 

AVR Core Clock frequency: 11.059200 MHz 
Memory model             : Small 

External RAM size       : 0 

Data Stack size              : 256 

****************************************************

*/ 

#include <mega16.h> 

#include <delay.h> 

#include <string.h>  
#include <stdlib.h> 

#include <stdio.h> 

#include <math.h> 

long int datax,datay,dataz; 
//long int old_datax,old_datay,old_dataz; 

eeprom long int kalx,kaly,kalz; 

#define RADDR 0x10 // common address parameter 

char buff[33]; 
int i; 

unsigned int xx,xx1,xx2,xx3; 

eeprom float old_dataf[10],old_datat[10]; 

eeprom int index; 
eeprom int range; 

eeprom int looping; 

// Alphanumeric LCD functions 

#include <alcd.h> 
// Timer1 overflow interrupt service routine 

interrupt [TIM1_OVF] void timer1_ovf_isr(void) 

{ 

// Reinitialize Timer1 value 
TCNT1H=0xD5D0 >> 8; 

TCNT1L=0xD5D0 & 0xff; 

// Place your code here 

    //rpm=(unsigned long int)frekuensi*60/2;  

    //frekuensi=0;    

} 

#ifndef RXB8 

#define RXB8 1 
#endif 

#ifndef TXB8 

#define TXB8 0 

#endif 
#ifndef UPE 

#define UPE 2 

#endif 

#ifndef DOR 
#define DOR 3 

#endif 

#ifndef FE 

#define FE 4 
#endif 

#ifndef UDRE 

#define UDRE 5 

#endif 
#ifndef RXC 

#define RXC 7 

#endif 

4.7 Pengujian Keseluruhan Sistem 
 Untuk mengetahui  sistem berfungsi dengan baik dan 

sesuai dengan spesifikasi perencanaan maka  akan dianalisis 

untuk dijadikan acuan dalam mengambil kesimpulan. Pengujian 
hasil dari alat penyangrai kopi secara otomatis yang disajikan 

dalam bentuk tabel pengujian. Pengukuran pada getaran HP dapat 

dilihat pada tabel dibawah ini 

Tabel 3. Data pengujian I 

 
 

 

 

 

 

 

 

 Gambar 6. Tampilan grafik X 
 

 

 

 
 

 

 

Gambar 7. Tampilan grafik y 
 

 

 

 
 

 

 

 
Gambar 8. Tampilan grafik Z 

 

4.7 Frekuensi yang dihasilkan berdasarkan hasil  pada  tabel 

diatas maka dapat di hitung secara perhitungan sebagai 
berikut: 

 

 

 

 

 

 
 

 
Gambar 9 hasil tampilan pada LCD 

 Pengukuran getaran adalah mengamati perpindahan 
benda yang di ukur dari posisi awal ke posisi yang lainnya 

padasaat bergetar.penulis mengambil sempel getaran yang di 



Journal of Informatics and Computer Science Vol. 8 No. 2 Oktober 2022 
Universitas Ubudiyah Indonesia  
e-ISSN : 2615-5346     

139 
 

hasilkan pada getaran Hp.Data yang didapat dari pengukuran 

dapat dilihat pada tabel dan grafik diatas.tabel 4.3 hasil 

pengukuran pada saat Hp bergetar.Hasil tampilan grafik yang di 
tampilkan adalah bentuk kuat lemah nya getaran yang diukur. 

Hasil pengukura yang ditampilkan pada LCD merupakan hasil 

rata rata dari penjumlam dari data X, Data Y dan Data Z yang di 

Konversikan oleh rumus kemudian di tampilkan pada LCD.  

 
V. Kesimpulan 

 Dari hasil pengukuran dan pengamatan yang telah 

dilakukan pada bab IV, hasil kerja alat dapat disimpulkan sebagai 

berikut: Nilai getaran yang dihasilkan sangat berpengaruh pada 

suber semakin tinggi getaran yang dibaca oleh sensor. Gerak 
getaran benda bergerak secara acak-acak atau ke segala 

arah.Grafikk tampilan gerakan getaran X,Ydan Z Respon 

pembacaan getaran menggunakan sensor accelerometer sangat 

sensitif. 
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